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Introduction 

The MSP430FR267x is a second generation family of CapTIvate™ Capacitive Touch FRAM 16-bit MCUs.  

CapTIvate™ Capacitive Touch Technology features flexibility that enables buttons, sliders, wheels and 

track/gesture pad HMI applications in any combination within the same design. 

For detailed information about CapTIvate™ Technology, CapTIvate™ Design Center and capacitive 

sensor design guidelines, refer to CapTIvate™ documentation located in: 

 CapTIvate™ Design Center GUI – select help > topics 

 On-line @ www.ti.com/CapTIvateTechGuide 

Overview 
The MSP430FR267x MCU with CapTIvate™ Technology supports basic Touchpad sensor functionality 

with as few as 8 CapTIvate IO pins (4x4 configuration) and up to 16 CapTIvate™ I/O pins (8x8 

configuration).  Pins not assigned to Touchpad functionality can be assigned as buttons, proximity, slider 

and wheel sensors. 

MSP430 FR267x CapTIvate™ Technology Features 

 Integrated CapTIvate IP 

 5uA typical with wake on proximity (great for battery powered applications) 

 Supports multiple combinations of sensors in the same design 

 CapTIvate Library in ROM allows more user code in FRAM 

Touch/Gesture Pad Features 

 Reports X,Y position and gesture 

 User programmable resolution (1000 pts default) 

 1 finger gestures (Swipe up, down, left, right, Tap, double-tap, tap and hold) 

 2 finger support is coming soon 

 Programmable Sensor Scan Rate 10ms (typical) , 5ms (min) 

 Supports overlay thickness up to 3mm ( 1-2 mm is typical) 

 Supports sensor configurations from 4x4 to 8x8 

 More details in performance section 

  

http://www.ti.com/CapTIvateTechGuide
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PCB Description 
The Touchpad design is a 50x50 mm mutual capacitive sensor in a 4x4 configuration with a 1.65 mm 

polycarbonate overlay on a 2-layer FR-4 PCB. 

 

Jumper (J3) is used to select the MSP430 VCC from the CAPT-PGMR PCB’s 3.3V LDO or 3.3V DC/DC.  For 

normal operation the 3.3V LDO is selected.  To measure the MSP430’s low power current the 3.3V 

DC/DC is selected.   

Jumper (J2) is used to direct the MSP430 UCA0 UART RXD and TXD signals to the CAPT-PGMR’s HID 

serial communications bridge which interfaces to the CapTIvate Design Center GUI (default).  Optionally, 

the UCA0 RXD and TXD signals can be routed to the CAPT-PGMR’s backchannel UART feature on the 

programmer.  This allows the user to create custom UART communications to send data or receive 

messages from a terminal application running the PC while at the same time sending sensor data and 

commands to the HID communications bridge using I2C. 

A reset button is provided to force the MSP430 into a reset state. 
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CapTIvate Programmer/Debugger 
The CAPTIVATE-PGMR PCB provides power and programming for the target MSP430.  In addition, it  

provides a USB HID serial communications Bridge device that translates the data and commands that 

flow between the CapTIvate Design Center GUI and the target MCU on the demo PCB, through a either 

the UART or I2C interface. 

The CAPTIVATE-PGMR PCB provides a 3.3V LDO output and a 3.3V DC/DC output.   For normal operation 

the 3.3V LDO can provide the target and associated circuits with up to 200mA.  The DC/DC is part of the 

EnergyTrace measurement circuit located on the CAPT-PGMR and is designed to work with Code 

Composer Studio to measure and display in real time the MSP430’s power and energy consumption. 

For more information about using EnergyTrace, visit the EnergyTrace landing page. 

 

 

  

https://www.ti.com/tool/ENERGYTRACE
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Required Software Tools and Installation instructions 

 Java run-time engine (JRE) version 1.7 or later is required 
o To verify which version you are using, from a command line prompt, type java –version 
o If update is needed, download and install the latest version from www.java.com 

 CapTIvate™ Design Center  
o TrackPad is supported in version 1.83.00.08 and later 
o PC GUI tool used to configure and tune sensors 
o Automatically generates firmware 
o Windows 7+, Apple-OS, Linux-OS 

 
 TI Code Composer Studio  

o IDE development platform 
o Need if modifying, programming and debugging firmware 

 
 Uniflash Utility [optional] 

o Flashes firmware images on target MCU using CAPT-PGMR 

PC Software Setup 

Follow the steps in order. 

1. Download and install TI Code Composer Studio (only select MSP430 support to minimize the 

download and installation time) 

2. Download and install CapTIvate Design Center GUI 

3. [optional] download and install Uniflash programming application 

4. Launch the CapTIvate Design Center GUI.  The very first time the GUI is launched, a CapTIvate 

Design Center workspace directory is created in 

c:\users[your name]\CaptivateDesignCenter_1_83_00_08\CaptivateDesignCenterWorkspace 

5. Copy the demonstration zip file into your new CapTIvate Design Center workspace directory and 

unzip the contents as shown below.  

 

 

  

http://www.java.com/
http://www.ti.com/CAPTIVATEDESIGNCENTER
http://www.ti.com/ccs
http://www.ti.com/tool/UNIFLASH
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Touchpad Demonstrations 
There are two versions of pre-compiled firmware images provided in the zip file. 

 TP4X4_FR2673_starter_demo.txt  (Active mode) 

 TP4X4_FR2673_lowpower_demo.txt ( Low-Power mode demonstrates proximity feature) 

Starter Demo 

The Touchpad PCB is provided pre-programmed with the Starter Demo firmware to demonstrate the 

tracking and gesture capabilities while communicating with the CapTIvate Design Center GUI. 

Low Power Demo 

This firmware demonstrates the MSP430’s low power capability.  When the Touchpad is not touched 

after 5 seconds the MSP430 enters a low power mode.  The CPU and all clocks have stopped except the 

CapTIvate Peripheral remains active scanning the touch pad once every 100msec looking for a touch to 

wake the system. 

Hardware Setup 

Perform the following: 

 Connect the Touchpad  to the CAPT-PGMR  

 Connect the micro-USB cable to the PC 

 Verify the  Power Good LED is on solid and the USB Enumeration LED blinks on/off 

Note:  Depending on the OS the USB enumeration LED may not stay illuminated all the time 
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Starter Demo #1 
To demonstrate the sensor’s active mode and the CapTIvate Design Center GUI the 

MCU must be programmed with the TP4X4_FR2673_starter_demo.txt firmware 

image.  

Operating in this mode, the MCU operates continuously, scanning the Touchpad 

sensor every 10ms.  Sensors status and data, which includes XY position and gesture 

information, is transmitted to the CapTIvate Design Center GUI where it can be 

viewed.  An LED turns on when a touch is detected. 

Exploring the GUI 

The following sections briefly describe portions of the CapTIvate Design Center GUI that are related to 

the Touchpad sensor and its operating parameters. 

Note:  This document does not cover the CapTIvate Design Center operation in detail.  For complete 

information about the GUI features, refer to the CapTIvate Design Center Technology Guide in the 

menu, File> Help>Topics or available here. 

Launch the CapTIvate Design Center GUI.   Open the TP4X4_FR2673 project by selecting from the GUI 

menu, File > ProjectOpen and click on TP4X4_FR2673 directory.  

 
Note: Opening a new project will prompt you to save changes – select DISCARD. 

 The CapTIvate Design Center Touchpad design project is shown here.  The touchpad sensor and 

MCU icon on the canvas represents the Touchpad sensor and MSP430FR2673 device on the 

demo PCB. 

 By default the GUI launches in “Basic” mode.  To see all of the user parameters select from the 

main menu Options>Features>Advanced 

 

 

http://www.ti.com/captivatetechguide
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Real Time Tuning Parameters 

Most CapTIvate peripheral and sensor operating parameters can be updated on the target MCU in real 

time using the CapTIvate Design Center.  Most are sensor parameters, but a few are related to the 

controller.  A user can tune a sensor’s response to a touch and other system parameters without having 

to re-program the MCU. 

When changing these parameters while connected to the CapTIvate Design 

Center, you will see the effects immediately.  However, these parameters 

are volatile so if power is cycled these values are lost.  To retain the 

updated parameters the configuration is updated and the MCU must be re-

programmed.   

 

Note:  After modifying an operating parameter, the APPLY button at the bottom of the current view will 

turn yellow.  Click the OK button to update the MCU with the new parameter value. 

 

 

 

Additionally, in each sensor view, all parameters have a hyper-link that provides a description of the 

parameter when selected.   Here is an example. 

 

 

 For more information about the operating parameters visit:  www.ti.com/CapTIvateTechGuide 

 

http://www.ti.com/CapTIvateTechGuide
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MCU Controller Parameters 

Let’s start by exploring with the controller properties.  To open the controller properties double-click on 

the MCU icon.  The controller (MCU) properties window offers several different views and configuration 

tabs that control sensor channel configuration, scan rate, low power wake on proximity scan rate, target 

interface and more.  To open the sensor properties window, double-click on the controller icon. 

 

 

MCU - Compile Time Options 

In the top portion of this view, certain compile time configurations can be selected, such as the target 

MCU, low power mode and communications interface between the GUI and target. 

 Any changes to these configurations require the MCU to be reprogrammed. 
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MCU - Conversion Control Tab 

The controller’s Conversion_Control tab has properties that control MCU functionality that relates to the 

capacitive touch measurements.  These parameters can be changed in real-time while communicating 

with the target MCU.   

 

Note: changes to these parameters are not permanent.  You must update the target project and re-

program the MCU with the changes (hence the term compile-time options). 

 Element Data Transmit Enable – Transmit sensor element data (count, LTA, etc.) to the GUI 

 Sensor Data Transmit Enable – Transmit sensor status (Touch, no-touch, etc.) to the GUI 

 Active Mode Scan Rate ms – Sensor measurement interval when MCU is in active mode 

 Wake on Prox Mode Scan Rate ms – Sensor measurement interval when MCU is in low power 

mode 

 Inactivity Timeout – After N number of samples and no touch is detected, MCU enters low 

power mode 

 Wakeup Interval – After N number of samples, force MCU to wake from low power mode to 

scan sensors and check other system parameters if needed. 

To see how the real-time modifications work, try changing the active scan rate from 10ms to 50ms, then 

click he APPLY button, then click OK and you will immediately see the sensor update slowdown from 

100Hz to 20Hz.  
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MCU - Scan Time Estimate  

This tab displays the total time estimated to measure the Touchpad sensor (blue bar) and the period at 

which the sensor is scanned (red line).  In this example it takes < 1ms to scan the Touchpad and mode 

button, leaving 18ms for other MCU operations, such as communicating with a host MCU or sending 

data to the GUI. 

Note: the scan time estimate does not include the Touchpad sensor processing time. 

 

 

Touchpad Sensor Parameters 

The Touchpad Sensor properties window offers several different views to monitor real time sensor data 

streaming from the target MCU as well as the ability to modify run-time parameters that control sensor 

sensitivity, scan rates and other design parameters. 

To open the sensor properties window, double-click on the touchpad sensor icon. 
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Sensor - Channel Bar View 

This view displays measurement information from each of the sensor’s electrode channels using bars to 

represent the strength of the signals and lines representing the proximity and touch thresholds 

 To enable communications, check the Target Communications Connected box as shown below 

 

 Select the Channel Bar Chart View 

 Move a finger around on the Touchpad sensor and the bars will change height due to the 

amount of change in capacitance introduced by the finger. 

A typical Channel Data view will look like this: 

 

 

Sensor - Touchpad Touch Plot View 

This view plots the XY position of the finger as it moves around the sensor.  In the upper right corner the 

XY data values are displayed along with the detected gesture. 

 Select the Touchpad  Touch Plot tab 

 Move a  finger around the Touchpad  sensor and the position is plotted 

 The absolute and delta positions are displayed 
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The supported gestures are Tap, Double-Tap, Tap-n-Hold, Swipe Up, Swipe Down, Swipe Left, and Swipe 

Right and are displayed in the upper right corner. 
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Touchpad Sensor Tuning Parameters 

The sensor properties window offers several different views and configuration tabs that control sensor 

operational parameters and allow the user to see real time sensor status and data coming from the 

target MCU.  To open the sensor properties window, double-click on the controller icon. 

Sensor - Conversion Control Tab 

The sensor’s Conversion_Control tab is where the sensor’s sensitivity parameters Conversion_Count and 

Conversion_Gain are located. 

 

 

 

Sensor - Tuning Tab 

The Tuning tab is where the majority of the sensor parameters are set.   This includes thresholds, filter 

betas, sensor resolution and debounce values. 
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The Tuning tab has additional parameters for controlling the gestures. 
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Low Power Demo #2 

Operating in this mode, the MCU is in a low power “wake on proximity” state, leaving the CapTIvate 

hardware to autonomously scan the sensor at a slower 100ms rate.  In this mode the device consumes 

the least amount of power (approximate 20uA).  Touching the sensor causes the MCU to exit the low 

power state, resuming sensor scanning and processing in the active mode at the faster 10ms rate and 

turning on the LED.  The MCU remains in this mode until the finger is removed.  The LED then turns off 

and the MCU re-enters the low-power state. 

Note, because the Touchpad PCB was designed to communicate with the CapTIvate Design Center GUI 

using the MSP430’s UART, operating the UART in the low power mode does not allow the MCU to 

achieve the lowest possible power.  To demonstrate the best low power, the MCU must us I2C, not 

UART. The TP4X4_FR2673_LowPower_demo.txt firmware uses I2C so it is still possible to view real-time 

data while the sensor is touched.  In order for this to work, you must select the “BULKI2C” mode in the 

Controller properties view. 

 

To re-program the MCU with TP4X4_FR2673_LowPower_demo.txt firmware, refer to the section “Re-

Programming the MCU.” 

  



  CapTIvate™ Technology TrackPad Guide 
 

18 
  

Measuring and verifying the low power current can be done easily in two different ways.  The first 

method requires a digital voltmeter (set in mA mode).  Remove the jumper on J3 and connect the meter 

as shown.  
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The second method uses the EnergyTraceTM feature built into the programmer and Code Composer 

Studio.   The EnergyTrace DC-DC circuit provides a separate +3.3v that it controls and measures the 

flowing current.  Remove the jumper from the center pin and LDO position and place it on the center pin 

and DC/DC pin. 

 

 

Next, launch Code Composer Studio and select the Energy Trace Icon. 

 

To start the current measurement, select the green “play” button. 

 

 

The default sampling period is 10 seconds (adjustable).  Current, power and energy information can be 

displayed. 
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Creating a New CapTIvate™ Design Center Touchpad Project 

This section describes in brief detail how to create a new sensor design project.  It is recommended to 

view the complete step by step descriptions in the CapTIvate Technology Design guide workshop 

chapter found in the GUI menu Help>Topics information or on the web. 

Note: the following illustrates the steps taken to create any new sensor configuration and PCB design.  

Configurations and settings specific to the Touchpad demo board will be highlighted. 

 

Start by creating a new project using the CapTIvate™ Design Center. 

 Note: the normal workflow for creating and configuring sensors are illustrated by the actions shown 

below. 

 

If the CapTIvate Design Center is already open, select from the menu:  File>NewProject.  You will be 

prompted to save the project.  Select Discard for now. 

Right-click once on the MCU icon, then click on the canvas to drop it in place.   

 

 

  

http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/CapTIvate_Design_Center/latest/exports/docs/users_guide/html/CapTIvate_Technology_Guide_html/markdown/ch_designcenter.html#captivate-design-center-quick-start
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Right-click once on the Touchpad icon, then click on the canvas to drop it in place. Your canvas should 

look something like the following: 

 

 

 

Double click on the Touchpad to view the touchpad properties.  Select mutual (projected) capacitive 

mode.  Select the element count and set = 16. 

 

This creates a 4x4 configuration (4 RX and 4 TX).  The element count represents the total measurement 

nodes created by the number of sensor RX channels times the number of TX channels.  

Next, double click on MCU to view the controller properties.  Select the MCU variant for your application 

by clicking in the device drop-down box.  The Touchpad demo PCB uses the MSP430FR2673IRHB. 
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At this point the controller properties show no connections between the sensor and the MCU. 

 

 

The next task is to assign the sensor’s RX and TX connections to the appropriate pins on the MCU. This 

can be done by hand and is challenging, especially for larger sensors, and if not done correctly the 

sensor’s performance can be suffer or will not work at all.  Therefore, TI recommends allowing the GUI 

to choose the connections by clicking on the “Auto-Assign” button. 

The Auto-Assign feature allows the CapTIvate Design Center to determine the optimal connections 

between the sensor and the pins on the MCU.  The controller view shows the measurement time cycles 

with the corresponding sensor elements.  From this view you can see that measuring the demo 

Touchpad sensor takes 10 measurement cycles. 

 

Note: The TP4X4_FR2673 starter demo PCB pin assignment shown here was routing manually.  This will 

not match the Auto-Assigned configuration. 
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The Configuration Connections above show the Time Cycles columns or measurement cycles. You can 

see that it requires 10 measurement cycles to measure the complete touchpad. The GUI can show an 

estimate of how long it will take to scan all 10 cycles.  Open the Scan Time Estimate tab.  You see that 

the 10 measurement cycles take only 1.58ms, and you can see how much time remains before the next 

time the sensor is measured.  This view gives some perspective of the percentage of the 20ms is 

consumed by the measurement process.  Note, there is always additional MCU processing that occurs 

post measurement but this time will vary and is difficult to estimate so it is not included.  
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The next step is to generate a new target MCU source code project, but you want to save your project 

first.  Next click on the “Generate Source Code” button, then select “Create New project”.  Note the 

location where this project is saved!  You will need to remember the directory name when importing the 

project into CCS. 

c:\users[your name]\CaptivateDesignCenter_1_83_00_08\CaptivateDesignCenterWorkspace 

 

Import Output Project into Code Composer Studio 

In Code Composer Studio, import the firmware project by navigating to the directory from above, then 

click on the project name. 

 

 

 

 

 

 

 

 

 

 Build and program the MCU 
 To run the demo from CCS, click the RUN icon or dis-connect then re-connect the USB cable 
 The MCU will start sending sensor data to the CapTIvate Design Center once the MCU wakes up 

after a swipe across the Trackpad  sensor 
 Verify everything works by moving your finger around the TrackPad and try the various gestures. 
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Sensor Tuning 
The sensor tuning procedure is described in the CapTIvate_touchpad_sensor_tuning_guide.pdf. 

For information on basic sensor tuning, refer to the Workshop Getting Started chapter in the CapTIvate 

Technology Guide. 

Gesture Tuning 
The gesture tuning procedure is described in the CapTIvate_touchpad_gesture_tuning_guide.pdf. 

Software 

CapTIvate Capacitive Touch Library Overview 

Refer to the CapTIvate Design Center documentation for additional information about the CapTIvate™ 

Touch library [click here].  

 

 

Touchpad Software Development 
The sensor tuning procedure is described in the CapTIvate_touchpad_software_development_guide.pdf. 

  

http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/CapTIvate_Design_Center/latest/exports/docs/users_guide/html/CapTIvate_Technology_Guide_html/markdown/ch_workshop.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/CapTIvate_Design_Center/latest/exports/docs/users_guide/html/ch_lib.html
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Re-Programming the MCU using TI Uniflash 
To re-program the provided demo firmware images use the TI Uniflash utility. 

Download and launch the Uniflash utility and follow the instructions that are provided.  Select the 

MSP430FR2673 (on-chip). 

 

Next, select the TI MSP430 USB1 connection. 

 

Click the Start button to establish communications with the CAPT-PGMR. 
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Click the Browse button and navigate to the CapTIvate design workspace directory where the 

demonstration project zip file contents were un-zipped and select the desired demo file (*.txt) in its 

respective folder. 

 

 

Click the Load Image button to re-flash the MCU with the new demo firmware. 
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Schematic/PCB 
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CAPT-PGMR Connections 

 


